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• For safety and warning information, please read this 
manual before attempting to use the equipment. 

• Additional safety and warning information is provided 
within the MG3700A Vector Signal Generator 
Operation Manual (Mainframe), MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) , or 
MS2690A/MS2691A/MS2692A Signal Analyzer 
Operation Manual (Mainframe Operation). Please also 
refer to either of these documents before using the 
equipment. 

• Keep this manual with the equipment. 
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Safety Symbols 
To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the 
following safety symbols to indicate safety-related information. Ensure that you clearly understand the meanings of 
the symbols BEFORE using the equipment. Some or all of the following symbols may be used on all Anritsu 
equipment. In addition, there may be other labels attached to products that are not shown in the diagrams in this 
manual. 
 

Symbols used in manual 
This indicates a very dangerous procedure that could result in serious injury or 
death if not performed properly. 
 

This indicates a hazardous procedure that could result in serious injury or death if 
not performed properly. 
 
This indicates a hazardous procedure or danger that could result in light-to-severe 
injury, or loss related to equipment malfunction, if proper precautions are not taken. 

 

Safety Symbols Used on Equipment and in Manual 
The following safety symbols are used inside or on the equipment near operation locations to provide information 
about safety items and operation precautions. Ensure that you clearly understand the meanings of the symbols and 
take the necessary precautions BEFORE using the equipment. 
 
 

 
This indicates a prohibited operation. The prohibited operation is indicated 
symbolically in or near the barred circle. 

 
  This indicates an obligatory safety precaution. The obligatory operation is 

indicated symbolically in or near the circle. 
 
  This indicates a warning or caution. The contents are indicated symbolically in or 

near the triangle. 
 
  This indicates a note. The contents are described in the box. 
 
 
  These indicate that the marked part should be recycled. 

 

MX370109A/MX269909A 
XG-PHS IQproducer 
Operation Manual 
 
31 October 2008 (First Edition) 
25 November 2014 (Fifth Edition) 
 
Copyright © 2008-2014, ANRITSU CORPORATION. 
All rights reserved. No part of this manual may be reproduced without the prior written permission of the 
publisher. 
The contents of this manual may be changed without prior notice. 
Printed in Japan 
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Equipment Certificate 
Anritsu Corporation guarantees that this equipment was inspected at 
shipment and meets the published specifications. 
 
 

Anritsu Warranty 
• During the warranty period, Anritsu Corporation will repair or exchange this 

software free-of-charge if it proves defective when used as described in the 
operation manual. 

• The warranty period is 6 months from the purchase date. 
• The warranty period after repair or exchange will remain 6 months from 

the original purchase date, or 30 days from the date of repair or 
exchange, depending on whichever is longer. 

• This warranty does not cover damage to this software caused by Acts of 
God, natural disasters, and misuse or mishandling by the customer. 

 
In addition, this warranty is valid only for the original equipment purchaser. It 
is not transferable if the equipment is resold. 
 
Anritsu Corporation shall assume no liability for injury or financial loss of the 
customer due to the use of or a failure to be able to use this equipment. 
 
 

Anritsu Corporation Contact 
In the event that this equipment malfunctions, contact an Anritsu Service and 
Sales office. Contact information can be found on the last page of the printed 
version of this manual, and is available in a separate file on the CD version. 
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Notes On Export Management 
This product and its manuals may require an Export License/Approval by 
the Government of the product's country of origin for re-export from your 
country. 
Before re-exporting the product or manuals, please contact us to confirm 
whether they are export-controlled items or not. 
When you dispose of export-controlled items, the products/manuals need 
to be broken/shredded so as not to be unlawfully used for military purpose. 
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Software End-User License Agreement (EULA) 
Please read this Software End-User License Agreement (hereafter this EULA) carefully before using 
(includes executing, copying, registering, etc.) this software (includes programs, databases, scenarios, etc., 
used to operate, set, etc., Anritsu electronic equipment). By reading this EULA and using this software, you 
are agreeing to be bound by the terms of its contents and Anritsu Corporation (hereafter Anritsu) hereby 
grants you the right to use this Software with the Anritsu-specified equipment (hereafter Equipment) for the 
purposes set out in this EULA. 
 
1. Grant of License and Limitations 

1. Regardless of whether this Software was 
purchased from or provided free-of-charge by 
Anritsu, you agree not to rent, lease, lend, or 
otherwise distribute this Software to third 
parties and further agree not to disassemble, 
recompile, reverse engineer, modify, or create 
derivative works of this Software. 

2. You may make one copy of this Software for 
backup purposes only. 

3. You are not permitted to reverse engineer 
this software. 

4. This EULA allows you to install one copy of 
this Software on one piece of Equipment.  

2. Disclaimers 
 To the extent not prohibited by law, in no 

event shall Anritsu be liable for personal 
injury, or any incidental, special, indirect or 
consequential damages whatsoever, 
including, without limitation, damages for 
loss of profits, loss of data, business 
interruption or any other commercial 
damages or losses, arising out of or related 
to your use or inability to use this Software. 

 
 

3. Limitation of Liability 
a. If a fault (bug) is discovered in this Software, 

preventing operation as described in the 
operation manual or specifications whether 
or not the customer uses this software as 
described in the manual, Anritsu shall at its 
own discretion, fix the bug, or exchange the 
software, or suggest a workaround, 
free-of-charge. However, notwithstanding 
the above, the following items shall be 
excluded from repair and warranty.  

i) If this Software is deemed to be used for 
purposes not described in the operation 
manual or specifications. 

ii) If this Software is used in conjunction with 
other non-Anritsu-approved software. 

iii) Recovery of lost or damaged data. 
iv) If this Software or the Equipment has been 

modified, repaired, or otherwise altered 
without Anritsu's prior approval. 

v) For any other reasons out of Anritsu's direct 
control and responsibility, such as but not 
limited to, natural disasters, software virus 
infections, etc. 

b. Expenses incurred for transport, hotel, daily 
allowance, etc., for on-site repairs by Anritsu 
engineers necessitated by the above faults 
shall be borne by you. 

c. The warranty period for faults listed in 
article 3a above covered by this EULA shall 
be either 6 months from the date of purchase 
of this Software or 30 days after the date of 
repair, whichever is longer. 
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4. Export Restrictions 
 You may not use or otherwise export or 

re-export directly or indirectly this Software 
except as authorized by Japanese and 
United States law. In particular, this 
software may not be exported or re-exported 
(a) into any Japanese or US embargoed 
countries or (b) to anyone on the Japanese or 
US Treasury Department's list of Specially 
Designated Nationals or the US Department 
of Commerce Denied Persons List or Entity 
List. By using this Software, you warrant 
that you are not located in any such country 
or on any such list. You also agree that you 
will not use this Software for any purposes 
prohibited by Japanese and US law, 
including, without limitation, the 
development, design and manufacture or 
production of missiles or nuclear, chemical or 
biological weapons of mass destruction. 

5. Termination 
 Anritsu shall deem this EULA terminated if 

you violate any conditions described herein. 
This EULA shall also be terminated if the 
conditions herein cannot be continued for 
any good reason, such as violation of 
copyrights, patents, or other laws and 
ordinances. 

6. Reparations 
 If Anritsu suffers any loss, financial or 

otherwise, due to your violation of the terms 
of this EULA, Anritsu shall have the right to 
seek proportional damages from you. 

7. Responsibility after Termination 
 Upon termination of this EULA in 

accordance with item 5, you shall cease all 
use of this Software immediately and shall 
as directed by Anritsu either destroy or 
return this Software and any backup copies, 
full or partial, to Anritsu. 

8. Dispute Resolution 
 If matters of dispute or items not covered by 

this EULA arise, they shall be resolved by 
negotiations in good faith between you and 
Anritsu. 

9. Court of Jurisdiction 
 This EULA shall be interpreted in 

accordance with Japanese law and any 
disputes that cannot be resolved by 
negotiation described in Article 8 shall be 
settled by the Japanese courts. 
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Cautions against computer virus infection 
• Copying files and data 
 Only files that have been provided directly from Anritsu or generated 

using Anritsu equipment should be copied to the instrument. 
 All other required files should be transferred by means of USB or 

CompactFlash media after undergoing a thorough virus check. 
• Adding software 
 Do not download or install software that has not been specifically 

recommended or licensed by Anritsu.  
• Network connections 
 Ensure that the network has sufficient anti-virus security protection in 

place. 
 
 



 

viii 

 

 

 
 

Protection Against Computer Virus Infections 

Prior to the software installation 
Before installing this software or any other software recommended or 
approved by Anritsu, run a virus scan on your computer, including 
removable media (e.g. USB memory stick and CF memory card) you 
want to connect to your computer. 
 
When using this software and connecting with the measuring instrument 
• Copying files and data 

On your computer, do not save any copies other than the following: 
 • Files and data provided by Anritsu 
 • Files created by this software 
 • Files specified in this document 

Before copying these files and/or data, run a virus scan, including 
removable media (e.g. USB memory stick and CF memory card). 

• Connecting to network 
Connect your computer to the network that provides adequate 
protection against computer viruses. 

 
 
 

Cautions on Proper Operation of Software 

This software may not operate normally if any of the following operations 
are performed on your computer: 
• Simultaneously running any software other than that recommended or 

approved by Anritsu 
• Closing the lid (Laptop computer) 
• Turning on the screen saver function 
• Turning on the battery-power saving function (Laptop computer) 
For how to turn off the functions, refer to the operation manual that came 
with your computer. 
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CE Conformity Marking 
Anritsu affixes the CE conformity marking on the following product(s) in 
accordance with the Council Directive 93/68/EEC to indicate that they 
conform to the EMC and LVD directive of the European Union (EU). 
 

CE marking 

 

1. Product Model 
Software: MX370109A/MX269909A XG-PHS IQproducerTM 

 
2. Applied Directive and Standards 
 When the MX370109A/MX269909A XG-PHS IQproducerTM is installed in 

the MG3710A, or MS2690A/MS2691A/MS2692A, the applied directive 
and standards of this software conform to those of the MG3710A, or 
MS2690A/MS2691A/MS2692A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370109A/MX269909A can be used with. 
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C-tick Conformity Marking 
Anritsu affixes the C-tick mark on the following product(s) in accordance with 
the regulation to indicate that they conform to the EMC framework of 
Australia/New Zealand. 
 

C-tick marking 

 

 
1. Product Model 

Software: MX370109A/MX269909A XG-PHS IQproducerTM 
 
2. Applied Directive and Standards 
 When the MX370109A/MX269909A XG-PHS IQproducerTM is installed in 

the MG3710A, or MS2690A/MS2691A/MS2692A, the applied directive 
and standards of this software conform to those of the MG3710A, or 
MS2690A/MS2691A/MS2692A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370109A/MX269909A can be used with. 
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About This Manual 

■Associated Documents 

The operation manual configuration of the MX370109A/MX269909A 
XG-PHS IQproducerTM is shown below.  

■If using MG3700A or MG3710A:  

Or 

 

MX370109A/MX269909A  
XG-PHS IQproducer™ Operation Manual  

MG3700A /MG3710A Vector Signal Generator  
MG3740A Analog Signal Generator Operation Manual (IQproducer™) 

MG3700A  
Vector Signal Generator  
Operation Manual (Mainframe) 

MG3710A Vector Signal Generator 
MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3700A Vector Signal Generator.  

 Or 

 MG3710A Vector Signal Generator MG3740A Analog Signal Generator 

Operation Manual (Mainframe) 

This describes basic operations, maintenance procedure, and remote 
functions of the MG3710A Vector Signal Generator and the MG3740A 
Analog Signal Generator.  

 

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 

Generator Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator and the Analog Signal 
Generator. 
 

 XG-PHS IQproducer™ Operation Manual (This document) 

This describes basic operations and functions of the XG-PHS IQproduc-
erTM.  
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■If using MS2690A/MS2691A/MS2692A:  

MX370109A/MX269909A  
XG-PHS IQproducer™ Operation Manual 

 

MS2690A/MS2691A/MS2692A  
Signal Analyzer Operation Manual  
(Main Frame Operation) 

MS2690A/MS2691A/MS2692A and MS2830A  
Signal Analyzer Operation Manual (Main Frame Remote Control) 

MS2690A/MS2691A/MS2692A Signal Analyzer Option 020:  
Vector Signal Generator  Operation Manual (Operation) 

MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: 
Vector Signal Generator Operation Manual (Remote Control) 

MS2690A/MS2691A/MS2692A and MS2830A 
Vector Signal Generator Operation Manual (IQproducer™) 
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 MS2690A/MS2691A/MS2692A Signal Analyzer Operation Manual (Main-

frame, Operation) 

This describes basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2690A/MS2691A/MS2692A.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A Signal Analyzer Operation 

Manual (Mainframe, Remote Control) 

These describe basic operations, maintenance procedure, common func-
tions and common remote functions of the MS2690A/MS2691A/MS2692A 
or MS2830A.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal 

Generator Operation Manual, Operation 

This describes the functions and how to use the Vector Signal Generator 
option. 
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector Signal 

Generator Operation Manual, Remote Control 

This describes how to remotely control the Vector Signal Generator op-
tion.  
---------------------------------------------------------------------------------------------- 

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 

Operation Manual (IQproducer™) 

This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator option. 
---------------------------------------------------------------------------------------------- 

 XG-PHS IQproducer™ Operation Manual (This document) 

This describes basic operations and functions of the XG-PHS IQproduc-
er™.  

 



 

IV 

Table of Contents 
 

Chapter 1 Overview ....................................  1-1 
1.1 Overview ....................................................................  1-2 

1.2 Product Composition .................................................  1-3 

 

 

Chapter 2 Preparation ................................  2-1 
2.1 Operating Environment ..............................................  2-2 

2.2 Installation/Uninstallation ...........................................  2-3 

2.3 Starting up and exiting the software ..........................  2-4 

 

 

Chapter 3 Detailed Description  

of Functions ..............................  3-1 
3.1 Screen Details ............................................................  3-2 

3.2 Waveform Pattern Generation Procedure .................  3-44 

3.3 Saving/Recalling Parameters ....................................  3-48 

3.4 User File Reading Screen ..........................................  3-51 

3.5 Displaying Graphs .....................................................  3-53 

3.6 Auxiliary Signal Output ..............................................  3-59 
 

 

Chapter 4 How to Use Waveform Patterns ....  4-1 
4.1 For MG3700A or MG3710A .......................................  4-2 

4.2 For MS2690A/MS2691A/MS2692A ...........................  4-6 



 

V 

 1 

 2 

 3 

 4 

A
p

p
en

d
ix

In
d

ex 

Appendix A Error Messages .......................  A-1 
 

Appendix B User File Format .....................  B-1 
 

Index  ................................................. Index-1 
 

 
 

 

 



 

VI. 

 



 
Chapter 1  Overview 

1-1 

1 

O
verview

 

This chapter provides an overview of the MX370109A/MX269909A 
XG-PHS IQproducer. 
 

1.1 Overview ....................................................................... 1-2 
1.2 Product Composition .................................................... 1-3 
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1.1 Overview 
MX370109A/MX269909A XG-PHS IQproducer (hereinafter referred to 
as “this software”) is software used to generate waveform patterns 
conforming to the Physical Channel Specification of the Next Generation 
PHS Specification. 

This software requires either of the following environment: 

• MG3710A Vector Signal Generator 
• MS2690A/MS2691A/MS2692A Signal Analyzer with Vector Signal 

Generator option mounted 
• Personal computer (hereinafter, “PC”) 
 
This software generates waveform patterns that support the 
specifications of XG-PHS with various characteristics. This is made 
possible by the editing/customizing of parameters according to its use.  

A waveform pattern created by this software can be output using an RF 
signal after being downloaded into the MG3700A Vector Signal 
Generator ,MG3710A Vector Signal Generator , or an 
MS2690A/MS2691A/MS2692A Signal Analyzer with Vector Signal 
Generator option installed (collectively referred to as “mainframe”, or 
“this equipment”). 
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1.2 Product Composition 
The following table lists the model name and specifications of this 
software according to the equipment. 

Table 1.2-1  Restrictions 

Mainframe 

 

Restrictions 

MG3700A MG3710A 
MS2690A 
MS2691A 
MS2692A 

Software name MX370109A MX269909A 

Maximum Size 
of Waveform 
Patterns 

256 M sample 
512 M sample*1 

64 M sample 
128 M sample*4 
256 M sample*5 
512 M sample*6 

256 M sample 

Transmission 
method of 
Waveform 
Patterns 

LAN, 
CompactFlash 
Card 

External device 
such as LAN, USB 
memory*2 

USB Memory and 
other external 
device *2 

Installation of 
this software to 
this equipment 

N/A Possible  Possible *3 

 
*1: The ARB memory expansion 512M sample (optional) must be 

installed into the MG3700A to use waveform patterns that exceed 
256 M samples. 

*2: Transferring waveform patterns is not required if the waveform 
patterns are created on the equipment using this software. 

*3: Although this software can be installed and run in the 
MS2690A/MS2691A/MS2692A, the measurement functions of the 
MS2690A/MS2691A/MS2692A are not guaranteed while this 
software runs. 

*4: The Combination of Baseband Signal (optional) must be installed 
into the MG3710A to use waveform patterns of maximum 128 M 
samples. 

*5: The ARB memory expansion 256M sample (optional) must be 
installed into the MG3710A to use waveform patterns of maximum 
256 M samples.  
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*6: To use waveform patterns of maximum 512 M samples, either of the 
following must be installed into MG3710A: 

• ARB memory expansion 1024 M sample (optional) 

• ARB memory expansion 256 M (optional) and Combination of 
Baseband Signal (optional) 

■Notes on waveform pattern conversion 

The waveform patterns generated with this software varies according to 
the main unit type. If using the waveform pattern to the different main 
unit, you need to convert the waveform pattern.  

For details about how to convert a waveform pattern, refer to each one of 
the following manuals.  

• MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen” 

• MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.5 “File Conversion on Convert Screen”  
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This chapter describes the operating environment for the 
MX370109A/MX269909A. 
 

2.1 Operating Environment .............................................. 2-2 
2.2 Installation/Uninstallation ........................................... 2-3 
2.3 Starting up and exiting the software .......................... 2-4 

2.3.1 Starting Software: When installed  

on other than MG3710A ................................ 2-4 
2.3.2 Starting Software: When installed  

on MG3710A ................................................. 2-6 
2.3.3 Exiting Software ............................................. 2-7 
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2.1 Operating Environment 
The following environment is required for operating the 
MX370109A/MX269909A. 

(1) PC that meets the following conditions 

OS Windows XP/Windows Vista/Windows 7 
CPU Pentium III 1 GHz equivalent or faster 
Memory 512 MB or more 

Hard disk space 

5 GB or more free space in the drive where 
this software is to be installed.  
The free hard disk space necessary to create 
waveform pattern varies depending on the 
waveform pattern size. The free disk space of 
27 GB or greater is required to create four 
maximum (512 Msample) waveform patterns. 

 
(2) If viewing on PC, displays with a resolution of 1024 × 768 pixels are 

best viewed using a small font setting. 
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2.2 Installation/Uninstallation 
This software is included in the IQproducer™ installer. It is 
automatically installed by installing the IQproducer™ that is supplied 
with this equipment or this software. When using a waveform pattern 
created using this software in the equipment, the license file must be 
installed in advance. 

■Installing/Uninstalling IQproducer™ 

For how to install and uninstall IQproducer™, refer to each of the 
following manuals:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
Chapter 2 “Installation” 

 

■Installing/Uninstalling IQproducer™ license file 

For how to install license file to MG3700A/MG3710A, refer to the 
following manual:  

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
5.1 “Installing License File” 
 

For how to uninstall license file from MG3700A/MG3710A, refer to each 
one of the following manuals:  

 MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.10.10 “Install” 

 MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 
9.4.4 “Install” 

 
Refer to the following manual for details of how to install/uninstall 
license file to MS2690A/MS2691A/MS2692A with Vector Signal 
Generator option.  

 MS2690A/MS2691A/MS2692A and MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
2.2 “Installation/Uninstallation” 
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2.3 Starting up and exiting the software 
This section explains how to start and stop this software. 

Note: 

The following explanation assumes the use of Windows XP. The 
screen image may differ slightly if not using Windows XP.  

 

2.3.1 Starting Software: When installed on other than MG3710A 
Start this software using the following procedure.  
The example assumes that it is a PC operation.  

<Procedure> 

1. Click Start on the task bar, and point to All Programs. Next, point to 
Anritsu Corporation, point to IQproducer, and then click 
IQproducer. 

 

2. When IQproducer™ starts, the Select instrument screen is 
displayed. 

On the Select instrument screen, select the model of the main unit 
that uses the waveform patterns created by IQproducer™.  

Notes: 

 This software does not support MS2830A and MG3740A. 

 To hide this screen and to start with the selected mainframe's 
screen from the next time, select the Don't show this window 
next time check box. 
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3. The common platform screen is displayed when OK is clicked in the 
Select instrument screen.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

 

Figure 2.3.1-1  Common Platform Screen 

 

4. Click the System (Cellular) tab on the common platform screen, to 
show the System (Cellular) selection screen that supports each 
telecommunication system.  

 

 

Figure 2.3.1-2  System (Cellular) Selection Screen 

 

5. Click XG-PHS to display the main screen. For details of the main 
screen, refer to Chapter 3 “Detailed Description of Functions”.  

Note: 

If Change Instrument is clicked, the Select instrument screen will 
appear each time the software is loaded.  
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2.3.2 Starting Software: When installed on MG3710A 
Start this software using the following procedure.  

<Procedure> 

1. Press  on the MG3710A front panel to display the common 
platform screen.  

The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 2.3.2-1  Common Platform Screen 

 

2. Click the System (Cellular) tab on the common platform screen, to 
show the System (Cellular) selection screen that supports each 
telecommunication system.  

 

Figure 2.3.2-2  System (Cellular) Selection Screen 
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3. Click XG-PHS to display the main screen. For details of the main 
screen, refer to Chapter 3 “Detailed Description of Functions”.  

Note: 

When this software is installed on MG3710A, Change Instrument 
displays instead of Interface Settings. Clicking Interface Settings 
displays the Interface Setting dialog box.  

 

Figure 2.3.2-3  Interface Settings Dialog Box 

 

Here, you can configure interface-related settings of IQproducer 
and MG3710A. To return to factory defaults, click Default.  

 Row Socket Port Number 

Sets Row Socket port number. Set the same value as that for 
MG3710A.  

 Wait Time 

Sets the wait time between commands.  

2.3.3 Exiting Software 
Stop this software using the following procedure. 
■When exiting only this software 
To exit only this software without closing the Common Platform screen, 
or other IQproducer™ tools, do one of these below: 

 Click the Exit button ( ) on the tool bar. 

 Select Exit from the File menu. 

 Click the  button on the upper right screen. 

 

Figure 2.3.3-1  Exiting Software 
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The operation of the three screen buttons is explained below.  

 

 

Figure 2.3.3-2  Exit Confirmation Window 

 

 Yes Saves current parameters to file and stops this 
software. 

 No Stops this software without saving current 
parameters to file. 

 Cancel or  Cancels the process and returns to the main screen. 
 
When stopping this software using the Yes button, the saved parameters 
are read at the next start and reset for each parameter.  

■When exiting entire IQproducer™ application 

To exit all tools of IQproducer™ that are running, select Exit on the 
Common Platform Screen. In this case, a dialog is displayed to confirm 
stopping of each running tool.  

 

Figure 2.3.3-3  Exiting IQproducer™ 
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This chapter provides detailed descriptions of this software.  

Notes: 

 The examples and screens used throughout this chapter are 
based on the assumption that the IQproducer™ is activated 
with the MG3700A.  

 The MG3710A and MS2690A/MS2691A/MS2692A functions are 
described as notes in each item.  
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3.1 Screen Details 
3.1.1 Menu and tool button 

On common platform screen, select the System (Cellular) tab, and then 
select XG-PHS to display the main screen. 

   Menu 
Tool bar 

Tree view 

Common parameter list

Physical Cannel/ 
Function Cannel 
parameter list 

Error display 

 

Figure 3.1.1-1  Main screen 

 

 Basic operations of main screen 

 The window can be maximized, minimized, expanded, and reduced.  

 Each field of the tree view, Common parameter list, Physical 
Channel parameter list, and error display can be moved by 
dragging to a separate position. 

 The leftmost symbol of each item in the tree view is – when the 
integrated items are open, or + when they are closed. Clicking the 
mark changes the status. 

 The items in italic cannot be changed. These items are set 
automatically. The state of each item may change depending on the 
setting for other items. 

 The grayed out items indicate parameters not related to the 
generated waveforms in the current setting and cannot be changed. 
The state of each item may change depending on the setting for 
other items. 
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 Screen transitions 

Figure 3.1.1-2 shows transitions from the main screen that is displayed 
when the XG-PHS IQproducer™ is started to other screens (Export File, 
Calculation, and Frame Structure screens). For details about each of the 
screens, refer to the sections shown below the corresponding screen. 

 

Main screen 

Export File screen 
(See 3.1.7 Export File screen.) 

Cancel

Calculation 

Calculation screen 
(See 3.1.8 Calculation screen.)

OK: At Calculation stop 

Cancel: During Calculation 

Frame Structure screen 
See 3.1.6 Frame Structure screen and Power graph.

Close Frame 
Structure screen 

Click Frame 
Structure display 

button 
OK 

 

Figure 3.1.1-2  Screen transition 
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■ [File] menu  

 

Figure 3.1.1-3  File menu 

 

 Select Option 

Notes: 

 This function is available only when MG3700, or MG3710 is 
selected in the Select instrument screen. 

 ARB Memory Expansion (option) is not available for 
MS269xA. Only Memory 256M samples, 1 GB is available.  

■When using MG3700A  

Select whether the ARB memory expansion option 256Msamples is 
installed. Selecting With Option21 (Memory 512M samples) 
supports creation of larger waveform patterns. If the ARB memory 
expansion option is not installed, the generated waveform pattern 
may not be able to be used. Waveform patterns cannot be created 
with a size greater than 256Msamples when Without Option21 
(Memory 512M samples) is selected. Select either according to the 
presence of ARB memory expansion option. 

 
Table 3.1.1-1  Available Options for MG3700A  

Items ARB Memory Expansion 

With Option21 (Memory 
512M samples) 1 GB x 2 memory 

Without Option21 (Memory 
512M samples): 512 MB × 2 Memories 
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■When using MG3710A 

 The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. 
Selecting the ARB Memory Expansion (option) and the Baseband 
Signal Combination Function (option) generates a bigger waveform 
pattern, while selecting the Baseband Signal Combination Function 
(option) generates a waveform pattern. If an uninstalled option is 
selected, sometimes the created waveform pattern may not be 
usable.  

 Set the combination of installed options based on the following 
setting items.  

Table 3.1.1-2  Available Options for MG3710A 

Items Combinations of Options 

Memory 64M samples None 

Memory 64M samples × 2 
Option48 
and 
Option 78 

Memory 256M samples 
Option45 
or 
Option 75 

Memory 256M samples × 2 
Option 45 and Option 48 
or 
Option 75 and Option 78 

Memory 1024M samples 
Option46 
or 
Option 76 

Memory 1024M samples × 2 
Option 46 and Option 48 
or 
Option 76 and Option 78 

 
The maximum size of the generated waveform pattern for each of 
the setting items is shown below.  

Table 3.1.1-3  Waveform Pattern Maximum Size 

Items Maximum Size 

Memory 64M samples 64M samples 
Memory 64M samples × 2 (With 
Option48, 78) 128M samples 

Memory 256M samples 256M samples 
Memory 256M samples × 2 (With 
Option48, 78) 512M samples 

Memory 1024M samples 512M samples 
Memory 1024M samples × 2 (With 
Option48, 78) 512M samples 
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 Recall Parameter File 
Loads the parameter files saved by the Save Parameter File menu. 
When the parameter file is loaded, the settings when it was loaded 
are recovered. 

 Save Parameter File 
Saves the current setting parameters to a file. 

 Reset Parameter 
Initialize all the parameters.  

 Exit 
Exits from this software. 

 

■ [Edit] Menu 

 

Figure 3.1.1-4  Edit menu 

 

 Calculation 
Generates waveform patterns. 

 Calculation & Load  
Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded into the MG3710A waveform memory.  

 Calculation & Play  
Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded and selected at the MG3710A waveform memory.  

 Show Frame Structure 
Starts Frame Structure screen. 

 Clipping 
Displays Clipping setting screen. In this screen, clipping and 
filtering processing can be performed for a generated waveform 
pattern. 
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■ [Transfer Setting] Menu 

 

 

Figure 3.1.1-5  Transfer Setting menu 

 

 Transfer & Setting Wizard  
Note: 

This function is available only when MG3700 or MG3710 is 
selected in the Select instrument screen. 

Displays the Transfer Setting Wizard screen. Every operation 
ranging from connecting the PC and MG3700A or MG3710A and 
transferring the waveform pattern to the MG3700A or MG3710A, 
to loading the waveform pattern into the MG3700A or MG3710A 
ARB memory is performed at this screen. 
 

■ [Simulation] menu 

 

Figure 3.1.1-6  Simulation menu 

 

 CCDF 
Displays the CCDF Graph Monitor screen. In this screen, the 
CCDF of the generated waveform pattern is displayed in a graph. 

 FFT 
Displays the FFT Graph Monitor screen. In this screen, the 
FFT-processed spectrum of the generated waveform pattern is 
displayed in a graph. 

 Time Domain 
Displays Time Domain screen. In this screen, the time domain 
waveform of a generated waveform pattern is displayed in a graph. 
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■ Tool buttons 

Notes: 

 Transfer&Setting Wizard is available only when MG3700 or 
MG3710 is selected in the Select instrument screen.  

 Calculation & Load and Calculation & Play are available 
only when this software is used on MG3710A. 

 

  Recall Parameter File 

  Save Parameter File 

  Calculation 

  Calculation & Load 

  Calculation & Play 

 Transfer & Setting Wizard 

 CCDF 

 FFT 

 Time Domain 

 Clipping 

  Show Segment Edit 

  Exit 

 

Clicking a tool button operates the same as the corresponding 
commands in the menu.  
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3.1.2 Tree view 
The tree view displays the parameter that belongs to the waveform 
pattern to be created as a hierarchy structure. Right-click Common at 
the tree view and select Add Channel to add a channel. Right-click each 
channel and select Delete Channel to delete the channel where the 
cursor is pointing. Channels can be added and deleted by setting Number 
of Channels in the common parameter list. 

 

Figure 3.1.2-1  Tree view 
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3.1.3 List of Common Parameters 
The items displayed in the common parameter list are described below. 
Parameters that require setting are listed in the common parameter list. 
The common parameters are displayed under Common. 

Link 

[Function] Sets signal Uplink, and Downlink. 
[Default] DL 
[Setting range] UL, DL 
[Remarks] The Physical Channel setting for each channel remains 

unchanged when Link changes but related parameters 
are initialized. 

 
ECBW 

[Function] Sets effective channel width. 
[Default] 8.1 MHz 
[Setting range] 8.1 MHz, 9.0 MHz, 16.2 MHz, 17.1 MHz, 18.0 MHz 
[Remarks] Channel settings are initialized when ECBW is 

narrowed prior to the change. 
 
Number of Frames 

[Function] Sets the number of frames to be generated. 
[Default] 1 
[Setting range] When Oversampling Ratio = 2 

ECBW = 8.1, 9.0 MHz 1 to 2796 
ECBW = 16.2, 17.1, 18.0 MHz, 1 to 1398 
When Oversampling Ratio = 4 
ECBW = 8.1, 9.0 MHz 1 to 1398 
ECBW = 16.2, 17.1, 18.0 MHz, 1 to 699 

[Resolution] 1 
[Remarks] The number of frames differs whether Option 21 is 

installed or not. This is explained in the table below. 
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Table 3.1.3-1  Number of frames for MG3700A 

Select Option Oversampling 
Ratio 

ECBW Number of 
frames 

With Option 21 
(Memory 512Msamples) 

2 
8.1, 9.0 MHz 1 to 5592 
16.2, 17.1, 18.0 MHz 1 to 2796 

4 
8.1, 9.0 MHz 1 to 2796 
16.2, 17.1, 18.0 MHz 1 to 1398 

Without Option 21(Memory 
512Msamples) 

2 
8.1, 9.0 MHz 1 to 2796 
16.2, 17.1, 18.0 MHz 1 to 1398 

4 
8.1, 9.0 MHz 1 to 1398 
16.2, 17.1, 18.0 MHz 1 to 699 

 

Table 3.1.3-2  Number of frames for MG3710A 

Select Option Oversampling 
Ratio 

ECBW Number 
of frames

Memory 64M samples 

2 
8.1, 9.0 MHz 1 to 699 
16.2, 17.1, 18.0 MHz 1 to 349 

4 
8.1, 9.0 MHz 1 to 349 
16.2, 17.1, 18.0 MHz 1 to 174 

Memory 64M samples x2  
(With Option48, 78) 

2 
8.1, 9.0 MHz 1 to 1398
16.2, 17.1, 18.0 MHz 1 to 699 

4 
8.1, 9.0 MHz 1 to 699 
16.2, 17.1, 18.0 MHz 1 to 349 

Memory 256M samples 

2 
8.1, 9.0 MHz 1 to 2796
16.2, 17.1, 18.0 MHz 1 to 1398

4 
8.1, 9.0 MHz 1 to 1398
16.2, 17.1, 18.0 MHz 1 to 699 

Memory 256M samples x2  
(With Option48, 78) 

2 
8.1, 9.0 MHz 1 to 5992
16.2, 17.1, 18.0 MHz 1 to 2796

4 
8.1, 9.0 MHz 1 to 2796
16.2, 17.1, 18.0 MHz 1 to 1398

Memory 1024M samples 

2 
8.1, 9.0 MHz 1 to 5992
16.2, 17.1, 18.0 MHz 1 to 2796

4 
8.1, 9.0 MHz 1 to 5992
16.2, 17.1, 18.0 MHz 1 to 2796

Memory 1024M samples x2 
(With Option48, 78) 

2 
8.1, 9.0 MHz 1 to 5992
16.2, 17.1, 18.0 MHz 1 to 2796

4 
8.1, 9.0 MHz 1 to 5992
16.2, 17.1, 18.0 MHz 1 to 2796
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Oversampling Ratio 

[Function] Sets oversampling ratio. 
[Default] 2 
[Setting range] 2, 4 
 
Windowing Length 

[Function] Sets Windowing length. 
[Default] 0 ns 
[Setting range] 0 to 2000 ns 
 
Filter Type 

[Function] Sets filtering type. 
[Setting range] Nyquist, Root Nyquist, Ideal, None 
[Default] None 
[Remarks] When Nyquist, Root Nyquist, or Ideal is selected, 

filtering is performed by setting frequencies within 1.1 
times ECBW as the passband, and frequencies above 
1.1 times ECBW as the stopband. Filtering is not 
performed when None is selected. 

 
Roll Off 

[Function] Sets roll-off ratio of filter. 
[Setting range] 0.1 to 1.0 
[Resolution] 0.1 
[Default] 0.1 
[Remarks] This setting is valid when Nyquist or Root Nyquist is 

selected for Filter Type. 
 
Filter Length 

[Function] Sets number of filter taps. 
[Setting range] 1 to 1024 
[Default] 255 
[Remarks] This setting is valid when Nyquist or Root Nyquist is 

selected for Filter Type. 
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Number of Channels 

[Function] Sets number of channels. 
[Default] 1 
[Setting range] ECBW = 8.1 MHz 1 to 36 
 ECBW = 9.0 MHz 1 to 40 
 ECBW = 16.2 MHz 1 to 72 
 ECBW = 17.1 MHz 1 to 76 
 ECBW = 18.0 MHz 1 to 80 
[Remarks] The maximum value for Number of Channels varies 

with the EXCH setting. 
 
BSID 

[Function] Sets Base Station ID. 
[Default] 0x0000 
[Setting range] 0x0000 to 0x7FFF 
 
MSID 

[Function] Sets Mobile Station ID. 
[Default] 0x0000 
[Setting range] 0x0000 to 0x7FFF 
 
Scrambling 

[Function] Sets scrambling ON/OFF. 
[Default] ON 
[Setting range] ON, OFF 
[Remarks] When ON is selected, the CRC bit is calculated by using 

MAC Header and MAC Frame, and then scrambling is 
performed for the areas of the MAC Header, MAC 
Frame, and CRC bit. Scrambling is not performed when 
OFF is selected. 

 
Encode 

[Function] Sets Encode ON/OFF. 
[Default] ON 
[Setting range] ON, OFF 
[Remarks] When OFF is selected, data is assigned to the areas of 

the MAC Header, MAC Frame, CRC bit, and TAIL bit. 
 
Interleave 

[Function] Sets Interleave ON/OFF. 
[Default] ON 
[Setting range] ON, OFF 
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3.1.4 Physical Channel Parameters (DL) 
This section explains each item displayed in the Physical Channel 
parameter list when Link is set to DL in the common parameter list. 

3.1.4.1 CCCH 
When CCCH is selected at Physical Channel Type, the following items 
are displayed in the Physical Channel parameter list. 

CCCH Allocation 

[Function] Sets PRU number for allocating CCCH 
[Default] Smallest free PRU number 
[Setting range] 1 to 80 
[Remarks] The setting range varies with the ECBW setting. A 

PRU that has already been allocated to another 
channel cannot be set. Allocation CCCH to one or two 
SCHs is permitted. 

 
Physical Channel Data Type 

[Function] Sets data to be inserted into CRC Calculation Area. 
[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File, Function 

Channel 
 
Physical Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into CRC 
Calculation Area. 

[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed when 16 bit repeat is selected at 

Physical Channel Data Type. 
 
Physical Channel User File 

[Function] Sets user file to be inserted into CRC Calculation Area. 
[Setting range] Any file can be selected. 
[Remarks] This is displayed when User File is selected at Physical 

Channel Data Type. Refer to Appendix B “User File 
Format” for details on the user file format. 
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Function Channel Data Type 

[Function] Sets type of data to be inserted into BCCH, SCCH or 
PCH. 

[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File 
[Remarks] This is displayed when Function Channel is selected for 

Physical Channel Data Type. 
 
Function Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into BCCH or 
PCH. 

[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed when 16 bit repeat is selected at 

Function Channel Data Type. 
 
Function Channel User File 

[Function] Sets user file to be inserted into BCCH or PCH. 
[Setting range] Any file can be selected. 
[Remarks] This is displayed when User File is selected at Function 

Channel Data Type. Refer to Appendix B “User File 
Format” for details on the user file format. 
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3.1.4.2 ANCH 
The following items are displayed in the Physical Channel parameter list 
when ANCH is selected at Physical Channel Type. 

ANCH Allocation 

[Function] Sets PRU number for allocating ANCH. 
[Default] Smallest free PRU number 
[Setting range] 1 to 80 
[Remarks] The setting range varies with the ECBW setting. A 

PRU that has already been allocated to another 
channel cannot be set. 

 
Physical Channel Data Type 

[Function] Sets type of data used as CRC Calculation Area. 
[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File, ECCH, 

ICCH 
[Remarks] The CI value is set automatically when ECCH or ICCH 

is selected. 
 
Physical Channel 16Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into CRC 
Calculation Area. 

[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed when 16 bit repeat is selected at 

Physical Channel Data Type. 
 
Physical Channel User File 

[Function] Sets user file to be inserted into CRC Calculation Area. 
[Setting range] Any file can be selected. 
[Remarks] This is displayed when User File is selected at Physical 

Channel Data Type. Refer to Appendix B “User File 
Format” for details on the user file format. 
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MAP Origin 

[Function] Sets MAP start position. 
[Default] 1 
[Setting range] ECBW = 8.1 MHz 0 to 8 
 ECBW = 9.0 MHz 0 to 9 
 ECBW = 16.2 MHz 0 to 17 
 ECBW = 17.1 MHz 0 to 18 
 ECBW = 18.0 MHz 0 to 19 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. 
 
MAP 

[Function] Sets MAP value. 
[Setting range] 0x000000000000000000 to 

0x7FFFFFFFFFFFFFFFFFF 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. The MAP value is automatically 
set according to each channel allocation, and cannot be 
set manually. 

 
SD 

[Function] Sets Shift Direction. 
[Default] Stay 
[Setting range] Stay, One Step Backward, Two Steps Forward, One 

Step Forward 
[Remarks] This is displayed when ECCH or ICCH is selected at 

Physical Channel Data Type. 
 
ANCH PC 

[Function] Sets ANCH Power Control value. 
[Default] 0x5555 5555 
[Setting range] 0x0000 0000 to 0xFFFF FFFF 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. One bit is set per frame, starting 
from upper bits. 

 
EXCH PC 

[Function] Sets EXCH Power Control value. 
[Default] 0x5555 5555 
[Setting range] 0x0000 0000 to 0xFFFF FFFF 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. Four bits are set per frame, 
starting from upper bits. 
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PC 

[Function] Sets the Power Control value. 
[Default] 0x5555 5555 
[Setting range] 0x0000 0000 to 0xFFFF FFFF 
[Remarks] This is displayed when ICCH is selected for Physical 

Channel Data Type. One bit is set per frame, starting 
from upper bits. 

 
ACK 

[Function] Sets ACK value. 
[Default] 0xF FFFF FFFF 
[Setting range] 0x0 0000 0000 to 0xF FFFF FFFF 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. 
 
V 

[Function] Sets Validity value. 
[Default] 0x7F 
[Setting range] 0x00 to 0x7F 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. When EXCH is set for another 
channel, the same value as Validity of EXCH is set and 
the maximum value is that of EXCH PRU Number. In 
this case, the number of MAC frames of EXCH is 
determined based on this value. 

 
MI 

[Function] Sets MI value. 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] This is displayed when ECCH is selected at Physical 
Channel Data Type. When EXCH is set for another 
channel, the same value as MCS of EXCH is set. MI 
cannot be set for slots to which EXCH is not assigned. 
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MR 

[Function] Sets MR value. 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] This is displayed when ECCH is selected at Physical 
Channel Data Type. 

 

HC 

[Function] Sets HARQ Cancel. 
[Default] 0 
[Setting range] 0, 1 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. 
 
Function Channel Data Type 

[Function] Sets type of data to be inserted into MAC Frame. 
[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File 
[Remarks] This is displayed when ICCH is selected at Physical 

Channel Data Type. 
 
Function Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into MAC Frame. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed only when 16 bit repeat is selected at 

Function Channel Data Type. 
 
Function Channel User File 

[Function] Sets user file to be inserted into MAC Frame. 
[Setting range] An arbitrary file can be selected. 
[Remarks] This is displayed only when User File is selected at 

Function Channel Data Type. Refer to Appendix B 
“User File Format” for details on the user file format. 
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3.1.4.3 EXCH 
The following items are displayed in the Physical Channel parameter list 
when EXCH is selected at Physical Channel Type. 

EXCH PRU Number 

[Function] Displays values of PRU for allocation of EXCH. 
[Default] Smallest free PRU number 
[Setting range] 1 to 80 
[Remarks] The maximum value depends on ECBW. EXCH 

Number is calculated based on the PRU set by EXCH 
Allocation. 

 
EXCH Allocation 

[Function] Sets PRU for allocation of EXCH. 
[Default] Smallest free PRU number 
[Setting range] ECBW = 8.1 MHz 1 to 36 

ECBW = 9.0 MHz 1 to 40 
ECBW = 16.2 MHz 1 to 72 
ECBW = 17.1 MHz 1 to 76 
ECBW = 18.0 MHz 1 to 80 

[Remarks] This cannot be set when the PRU is already allocated to 
another channel. Click the PRU number to open the 
setting screen. 

 
Physical Channel Data Type 

[Function] Sets data to be inserted into CRC Calculation Area. 
[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File, EDCH 
 
Physical Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into CRC 
Calculation Area. 

[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed when 16 bit repeat is selected for 

Physical Channel Data Type. 
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Physical Channel User File 

[Function] Sets data file to be inserted into CRC Calculation Area. 
[Setting range] Any file can be selected. 
[Remarks] This is displayed when User File is selected for Physical 

Channel Data Type. Refer to Appendix B “User File 
Format” for details on the user file format. 

 
Function Channel Data Type 

[Function] Sets type of data to be inserted into MAC Frame. 
[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File 
[Remarks] This is displayed when EDCH is selected for Physical 

Channel Data Type. 
 
Function Channel 16 Bit Repeat 

[Function] Sets 16 -bit repeat data to be inserted into MAC Frame. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed only when 16 bit repeat is selected at 

Function Channel Data Type. 
 
Function Channel User File 

[Function] Sets user file to be inserted into MAC Frame. 
[Setting range] Any file can be selected. 
[Remarks] This is displayed only when User File is selected at 

Function Channel Data Type. Refer to Appendix B 
“User File Format” for details on the user file format. 

 
MCS 

[Function] Sets type of MCS 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] QPSK-4/6 is set for slots to which EXCH is not assigned. 
If Physical Channel Type and Physical Channel Data 
Type are set to ANCH and ECCH for another channel, 
respectively, the same value as MI of ANCH is set. 
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PRU Concatenation 

[Function] Sets PRU Concatenation 
[Default] OFF 
[Setting range] ON, OFF 
[Remarks] When PRU Concatenation is set to ON, a data symbol 

is assigned to all EXCH subcarriers (except the one at 
the center of the ECBW). 

 
Validity 

[Function] Sets the valid PRU of EXCH. 
[Default] 0 
[Setting range] 0 to EXCH PRU Number 
[Remarks] If Physical Channel Type and Physical Channel Data 

Type are set to ANCH and ECCH for another channel, 
respectively, the same value as V of ANCH is set. 
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3.1.4.4 CSCH 
The following items are displayed in the Physical Channel Parameter list 
when CSCH is selected at Physical Channel Type. 

CSCH Allocation 

[Function] Sets PRU number for allocation of CSCH. 
[Default] Smallest free PRU number 
[Setting range] 1 to 80 
[Remarks] The setting range varies with the ECBW setting. A 

PRU that has already been allocated to another 
channel cannot be set. 

 
Physical Channel Data Type 

[Function] Sets type of data to be inserted in CRC Calculation 
Area. 

[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File, TCH, 

CDCH 
[Remarks] The CI value is set automatically when TCH or CDCH 

is selected. 
 
Physical Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into CRC 
Calculation Area. 

[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed when 16 bit repeat is selected at 

Physical Channel Data Type. 
 
Physical Channel User File 

[Function] Sets data file to be inserted into CRC Calculation Area. 
[Setting range] An arbitrary file can be selected. 
[Remarks] This is displayed when User File is selected at Physical 

Channel Data Type. Refer to Appendix B “User File 
Format” for details on the user file format. 
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MCS 

[Function] Sets type of MCS. 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] This is displayed when a channel other than TCH or 
CDCH is selected for Physical Channel Data Type. 

 
MI 

[Function] Sets MI value. 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] This is displayed when TCH or CDCH is selected at 
Physical Channel Data Type. 

 
MR 

[Function] Sets MR value. 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] This is displayed when TCH or CDCH is selected at 
Physical Channel Data Type. 

 
SD 

[Function] Sets Shift Direction. 
[Default] Stay 
[Setting range] Stay, One Step Backward, Two Steps Forward, One 

Step Forward 
[Remarks] This is displayed when TCH or CDCH is selected at 

Physical Channel Data Type. 
 
PC 

[Function] Sets Power Control value. 
[Default] 0x5555 5555 
[Setting range] 0x0000 0000 to 0xFFFF FFFF 
[Remarks] This is displayed when TCH or CDCH is selected at 

Physical Channel Data Type. One bit is set per frame, 
starting from upper bits. 
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ACK 

[Function] Sets ACK value. 
[Default] 0 
[Setting range] 0, 1 
[Remarks] This is displayed when CDCH is selected at Physical 

Channel Data Type. 
 
Function Channel Data Type 

[Function] Sets type of data to be inserted into Mac Frame. 
[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File 
[Remarks] When TCH is selected for Physical Channel Data Type, 

select one data type for ACCH and TCH. 
 
Function Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into MAC frame. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed when 16 bit repeat is selected at 

Function Channel Data Type. 
 
Function Channel User File 

[Function] Sets user file to be inserted into MAC Frame. 
[Setting range] An arbitrary file can be selected. 
[Remarks] This is displayed when User File is selected at Function 

Channel Data Type. Refer to Appendix B “User File 
Format” for details on the user file format. 
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3.1.5 Physical Channel Parameters (UL) 
This section explains each of the items that are displayed in the Physical 
Channel parameter list when Link in the common parameter list is set to 
UL. 

3.1.5.1 CCCH 
CCCH Allocation 

[Function] Sets PRU number for allocation of CCCH. 
[Default] Smallest free PRU number 
[Setting range] 1 to 80 
[Remarks] The setting range varies with the ECBW setting. A 

PRU that has already been allocated to another 
channel cannot be set. Allocation CCCH to one or two 
SCH is permitted. 

 
Physical Channel Data Type 

[Function] Sets data to be inserted into Control Field. 
[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File, Function 

Channel 
 
Physical Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into Control Field. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed when 16 bit repeat is selected at 

Physical Channel Data Type. 
 
Physical Channel User File 

[Function] Sets user file to be inserted into Control Field. 
[Setting range] An arbitrary file can be selected. 
[Remarks] This is displayed when User File is selected at Physical 

Channel Data Type. Refer to Appendix B “User File 
Format” for details on the user file format. 
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Function Channel Data Type 

[Function] Sets type of data to be inserted into BCCH, SCCH or 
PCH. 

[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File 
[Remarks] This is displayed when Function Channel is selected for 

Physical Channel Data Type. 
 
Function Channel 16 Bit Repeat 

[Function] Sets the 16-bit repeat data to be inserted into BCCH or 
PCH. 

[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed when 16 bit repeat is selected at 

Function Channel Data Type. 
 
Function Channel User File 

[Function] Sets user file to be inserted into BCCH or PCH. 
[Setting range] Any file can be selected. 
[Remarks] This is displayed when User File is selected at Function 

Channel Data Type. Refer to Appendix B “User File 
Format” for details on the user file format. 
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3.1.5.2 ANCH 
The following items are displayed in the Physical Channel parameter list 
when ANCH is selected at Physical Channel Type. 

ANCH Allocation 

[Function] Sets PRU number for allocation of ANCH 
[Default] Smallest free PRU number 
[Setting range] 1 to 80 
[Remarks] The setting range varies with the ECBW setting. A 

PRU that has already been allocated to another 
channel cannot be set. 

 
Physical Channel Data Type 

[Function] Sets type of data.  
[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File, ECCH, 

ICCH 
[Remarks] The CI value is set automatically when ECCH or ICCH 

is selected. 
 
Physical Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into CRC 
Calculation Area. 

[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] Sets 16-bit repeat data to be inserted into CRC 

Calculation Area. 
 
Physical Channel User File 

[Function] Sets user file to be inserted into CRC Calculation Area. 
[Setting range] Any file can be selected. 
[Remarks] This is displayed when User File is selected at Physical 

Channel Data Type. Refer to Appendix B “User File 
Format” for details on the user file format. 

 
RCH 

[Function] Sets RCH value. 
[Default] 0x00 
[Setting range] 0x00 to 0x7F 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. The RCH value includes reserved 
bits. 
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ANCH PC 

[Function] Sets ANCH Power Control value. 
[Default] 0x5555 5555 
[Setting range] 0x0000 0000 to 0xFFFF FFFF 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. One bit is set per frame, starting 
from upper bits. 

 
EXCH PC 

[Function] Sets EXCH Power Control value. 
[Default] 0x5555 5555 
[Setting range] 0x0000 0000 to 0xFFFF FFFF 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. 
 
ACK 

[Function] Sets ACK value. 
[Default] 0xF FFFF FFFF 
[Setting range] 0x0 0000 0000 to 0xF FFFF FFFF 
[Remarks] This is displayed when ECCH is selected at Function 

Channel Data Type. 
 
V 

[Function] Sets Validity value. 
[Default] 0x7F 
[Setting range] 0x0 0000 to 0xF FFFF 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. When EXCH is set for another 
channel, the same value as Validity of EXCH is set and 
the maximum value varies according to the EXCH PRU 
Number. In this case, the number of MAC frames of 
EXCH is determined based on this value. 

 
MI 

[Function] Sets MI value. 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] This is displayed when ECCH is selected at Physical 
Channel Data Type. When EXCH is set for another 
channel, the same value as MCS of EXCH is set. In this 
case, the MI value is fixed to QPSK4/6 for slots to which 
EXCH is not assigned. 
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MR 

[Function] Sets MR value. 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] This is displayed when ECCH is selected at Physical 
Channel Data Type. 

 
HC 

[Function] Sets HARQ Cancel value. 
[Default] 0 
[Setting range] 0, 1 
[Remarks] This is displayed when ECCH is selected at Physical 

Channel Data Type. 
 
Function Channel Data Type 

[Function] Sets type of data to be inserted into MAC Frame 
(ICCH). 

[Default] PN9 
[Setting range] PN9, PN15, 16 bit repeat, User File 
[Remarks] This is displayed when ICCH is selected for Physical 

Channel Data Type. 
 
Function Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into MAC Frame 
(ICCH). 

[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed when 16 bit repeat is selected for 

Function Channel Data Type. 
 
Function Channel User File 

[Function] Sets user file to be inserted into MAC Frame (ICCH). 
[Setting range] Any file can be selected. 
[Remarks] This is displayed when User File is selected for 

Function Channel Data Type. Refer to Appendix B 
“User File Format” for details on the user file format. 
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3.1.5.3 EXCH 
The following items are displayed in the Physical Channel parameter list 
when EXCH is selected at Physical Channel Type. 

EXCH PRU Number 

[Function] Displays value of PRU for allocation of EXCH. 
[Default] Smallest free PRU number 
[Setting range] 1 to 80 
[Remarks] The maximum value depends on ECBW. EXCH 

Number is calculated based on the PRU set by EXCH 
Allocation. 

 
PRU Allocation 

[Function] Sets PRU number for allocation of EXCH. 
[Default] Smallest free PRU number 
[Setting range] ECBW = 8.1 MHz 1 to 36 

ECBW = 9.0 MHz 1 to 40 
ECBW = 16.2 MHz 1 to 72 
ECBW = 17.1 MHz 1 to 76 
ECBW = 18.0 MHz 1 to 80 

[Remarks] This cannot be set when the PRU is already allocated to 
another channel. 

 
Physical Channel Data Type 

[Function] Sets data type. 
[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File, EDCH 
 
Physical Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into CRC 
Calculation Area. 

[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed when 16 bit repeat is selected for 

Physical Channel Data Type. 
 
Physical Channel User File 

[Function] Sets user file to be inserted into CRC Calculation Area. 
[Setting range] Any file can be selected. 
[Remarks] This is displayed when User File is selected for Physical 

Channel Data Type. Refer to Appendix B “User File 
Format” for details on the user file format. 
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Function Channel Data Type 

[Function] Sets type of data to be inserted into Control Field. 
[Default] PN9 
[Setting range] PN9, PN15, 16 bit repeat, User File 
 
Function Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into Control Field. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed only when 16 bit repeat is selected at 

Function Channel Data Type. 
  
Function Channel User File 

[Function] Sets user file to be inserted into Control Field. 
[Setting range] Any file can be selected. 
[Remarks] This is displayed only when User File is selected at 

Function Channel Data Type. Refer to Appendix B 
“User File Format” for details on the user file format. 

 
MCS 

[Function] Sets type of MCS 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] If Physical Channel Type and Physical Channel Data 
Type are set to ANCH and ECCH for another channel, 
respectively, the same value as MI of ANCH is set. The 
MCS value is fixed to QPSK-4/6 for slots to which 
EXCH is not assigned. 
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Validity 

[Function] Sets the valid PRU for EXCH. 
[Default] Number of EXCH PRUs for each slot 
[Setting range] 0 to the number of EXCH PRUs for each slot 
[Remarks] If Physical Channel Type and Physical Channel Data 

Type are set to ANCH and ECCH for another channel, 
respectively, this value is set to V of ANCH. 

 Double-click the set value to open the Validity setting 
screen, and then set the valid number of EXCHs for 
each slot.  

 

Figure 3.1.5.3-1  Validity setting screen 
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3.1.5.4 CSCH 
The following items are displayed in the Physical Channel Parameter list 
when CSCH is selected at Physical Channel Type. 

CSCH Allocation 

[Function] Sets PRU number for allocation of CSCH. 
[Default] Smallest free PRU number 
[Setting range] 1 to 80 
[Remarks] The setting range varies with the ECBW setting. A 

PRU that has already been allocated to another 
channel cannot be set. 

 
Physical Channel Data Type 

[Function] Sets data to be inserted in CRC Calculation Area. 
[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File, TCH, 

CDCH 
[Remarks] The CI value is set automatically when TCH or CDCH 

is selected. 
 
Physical Channel 16 Bit Repeat 

[Function] Sets 16-bit repeat data to be inserted into CRC 
Calculation Area. 

[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed when 16 bit repeat is set at Physical 

Channel Data Type. 
 
Physical Channel User File 

[Function] Sets user file to be inserted into CRC Calculation Area. 
[Setting range] Any file can be selected. 
[Remarks] This is displayed when User File is selected at Physical 

Channel Data Type. Refer to Appendix B “User File 
Format” for details on the user file format. 

 
MCS 

[Function] Sets type of MCS. 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] This is displayed when a channel other than TCH or 
CDCH is selected for Physical Channel Data Type. 
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MI 

[Function] Sets MI value. 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] This is displayed when TCH or CDCH is selected at 
Physical Channel Data Type. 

 
MR 

[Function] Sets MR value. 
[Default] QPSK-4/6 
[Setting range] BPSK-1, BPSK-3/4, QPSK-1, QPSK-4/6, 16QAM-1, 

16QAM-4/6, 64QAM-3/4, 64QAM-6/10, 256QAM-4/6, 
256QAM-8/14 

[Remarks] This is displayed when TCH or CDCH is selected at 
Physical Channel Data Type. 

 
PC 

[Function] Sets Power Control value. 
[Default] 0x5555 5555 
[Setting range] 0x0000 0000 to 0xFFFF FFFF 
[Remarks] This is displayed when TCH or CDCH is selected at 

Physical Channel Data Type. 
 
ACK 

[Function] Sets ACK value. 
[Default] 0 
[Setting range] 0, 1 
[Remarks] This is displayed when CDCH is selected at Physical 

Channel Data Type. 
 
Function Channel Data Type 

[Function] Sets type of data to be inserted into MAC Frame. 
[Default] PN9 
[Setting range] PN9, PN15, PN23, 16 bit repeat, User File 
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Function Channel 16Bit Repeat Data 

[Function] Sets 16-bit repeat data to be inserted into MAC Frame. 
[Default] 0x0000 
[Setting range] 0x0000 to 0xFFFF 
[Resolution] 1 
[Remarks] This is displayed only when 16 bit repeat is selected at 

Function Channel Data Type. 
 
Function Channel User File 

[Function] Sets user file to be inserted into MAC Frame. 
[Setting range] Any file can be selected. 
[Remarks] This is displayed only when User File is selected at 

Function Channel Data Type. Refer to Appendix B 
“User File Format” for details on the user file format. 
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3.1.6 Frame Structure screen and power graph 
The Frame Structure screen opens when Show Frame Structure is 
selected at the Edit menu of the Main screen or when  on the 
Toolbar is clicked. The Frame Structure screen indicates which Physical 
Channel is allocated each PRU. Each channel is displayed in a different 
color. 

 Power Graph Display On/Off Button 

Full Scale Button 

 

Figure 3.1.6-1  Frame Structure screen and power graph 

 

3.1.6.1 Frame Structure screen 
The Frame Structure screen displays frequency on the vertical axis and 
time in Slot units on the horizontal axis. 
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3.1.6.2 Power graph 
The power graph can be displayed and hidden by clicking the show/hide 
button at the top left corner of the Frame Structure screen. The vertical 
axis indicates power as a ratio to the slot with the maximum power 
expressed as 0 dB. The horizontal axis indicates the match with the Slot 
time axis. 

The power graph shows using the power of Training Symbol (0 dB) as a 
reference, whose slot has the greatest number of allocated channels.  

This Training Symbols becomes the Amplitude defined by the mainframe.  
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3.1.7 Export File screen 
When Calculation is selected from the Edit menu or the   tool 
button is clicked on the main screen, the Export File screen shown in 
Figure 3.1.7-1 is displayed.  
The Export File screen is displayed when generating a waveform pattern. 
The output destination folder, package name, file name, and comment for 
the waveform pattern to be generated can be specified in this screen.  

 
Button selecting output 
destination folder 
Package name 

File name 

Comment 

 

Figure 3.1.7-1  Export File screen 

 

Only 1-byte alphanumeric characters and the following symbols can be 
used for a file name and package name.  
! % & ( ) + = ` { } _ - ^ @ [ ] 

When the waveform pattern output destination folder, package name, file 
name, and comment are set, click OK on the Export File screen. The 
Calculation screen shown in Figure 3.1.8-1 is displayed and waveform 
pattern generation starts (the output destination folder, package name, 
and file name must be set to start waveform pattern generation).  
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When started with MS269x and when MS269x is selected in the Select 
instrument screen, waveform pattern files generated by this application 
are saved in the following directory:   

Installed OS Export destination folder 

Windows Embedded 
Standard 7 

C:\Anitsu\Signal Analyzer\ 
System\Waveform 

Other than above C:\Program Files\Anritsu Corporation\ 
Signal Analyzer\System\Waveform 

 
When used with MG3710A, the files are saved in the following directory: 
C:\Anritsu\MG3710A\User Data\Waveform 

In other cases, the output destination folder selection button is clicked, 
the folder selection screen shown in Figure 3.1.7-2 is displayed. Select 
the output destination folder. If it is not specified, the generated 
waveform patterns are output to the path X:\IQproducer\XG-PHS\Data 
(X:\IQproducer indicates the folder where the IQproducer™ is installed.) 

 

Figure 3.1.7-2  Folder selection screen 
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3.1.8 Calculation screen 
Clicking Calculation & Load, Calculation & Play, or the OK button on 
the Export File screen will start the waveform generation.  

The Calculation screen is displayed while a waveform pattern is being 
generated. On this screen, the progress bar is displayed indicating the 
generation process of the waveform pattern and the progress of the 
waveform pattern generation. The generation of the waveform pattern 
can be stopped by clicking the Cancel button. When cancelled, it returns 
to the main screen.  

 

Progress report

Progress bar

Cancel button
 

Figure 3.1.8-1  Calculation Screen (In Progress) 

 

After waveform pattern generation is finished, the message “Calculation 
Completed.” is displayed in the progress window and the Cancel button 
changes to the OK button.  

When the generation is complete, you can return to the setting screen by 
clicking the OK button. After waveform generation, two files with .wvi 
and .wvd extension are output.   
 

 

 

Figure 3.1.8-2  Calculation Screen (Completed) 

Note: 

When using this software on MG3710A, and selecting Calculation 
& Load or Calculation & Play, the waveform generation ends 
without displaying the above screen.  
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3.1.9 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A.  

When Calculation & Load is selected, the Load Setting screen will 
display after waveform generation.  

Button for selecting load destination 

 

 

Figure 3.1.9-1  Load Setting Screen 

 

The Select Memory screen will display after clicking the load destination 
in the Load Setting screen.  

 

Figure 3.1.9-2  Select Memory Screen 

After selecting the load destination of generated waveform in the Select 
Memory screen and clicking the OK button, the Load Setting screen will 
be shown again. Click the OK button in the Load Setting screen, and 
then the loading of waveform starts.  

Note: 

To exit this screen without loading the waveform pattern, click the 
Cancel button in the Load Setting screen.  
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3.1.10 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A.  

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output.  

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 3.1.10-1  Select SG Screen 
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3.2 Waveform Pattern Generation Procedure 
3.2.1 Setting parameters and creating waveform pattern 

This section describes the waveform pattern generation procedure, using 
the XG-PHS waveform pattern for which the parameters are set as 
shown in Table 3.2.1-1 as an example.  

Table 3.2.1-1  Settings for common parameters 

Parameter Settings 

Link DL 
ECBW 8.1 MHz 

Number of Frames 20 
Oversampling Ratio 2 
Windowing Length 0 

Filter Type None 
Number of Channels 4 

BSID 0x0000 
MSID 0x7FFF 

Encode ON 
Scramble ON 
Interleave ON 

 
Procedure 

[Creating Downlink waveform] 
A Downlink waveform is created here as an example. 

1. Start this software. 

2. Set the common parameters as shown in Table 3.2.1-1. 

3. Click CH#1 of the tree view and set the CCCH parameters as shown 
in Table 3.2.1-2. 

Table 3.2.1-2  CCCH Settings 

Parameter Settings 

Physical Channel Type CCCH 
CCCH Allocation 1 

Data Type Function Channel 
Function CH Data Type PN9 

4. Click CH#2 of the tree view and set the ANCH parameters as shown 
in Table 3.2.1-3. 
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Table 3.2.1-3  ANCH Settings 

Parameter Settings 

Physical Cannel Type ANCH 
ANCH Allocation 6 

Data Type  ECCH 
MAP Origin 1 

SD Stay 
ANCH_PC 0x5555 5555 
EXCH_PC 0xAAAA AAAA 

ACK 0xF FFFF FFFF 
V 0x7F 

Slot #1 MI QPSK-4/6 
Slot #2 MI 16QAM-4/6 
Slot #3 MI 64QAM-6/10 
Slot #4 MI 256QAM-8/14 
Slot #1 MR 64QAM-3/4 
Slot #2 MR 16QAM-1 
Slot #3 MR QPSK-1 
Slot #4 MR BPSK-1 

HC 1 

5. Click CH#3 of the tree view and set the CSCH parameters as shown 
in Table 3.2.1-4. 

Table 3.2.1-4  CSCH Settings 

Parameter Settings 

Physical Cannel Type CSCH 
CSCH Allocation 7 

Data Type CDCH 
MI 16QAM-4/6 
MR 64QAM-3/4 
SD Stay 
PC 0x5555 5555 

ACK 0 
Data Type PN23 

6. Click CH#4 of the tree view and set the EXCH parameters as shown 
in Table 3.2.1-5. 
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Table 3.2.1-5  CSCH Settings 

Parameter Settings 

Physical Cannel Type EXCH 
EXCH Allocation #1 PRU = 9 
EXCH Allocation #2 PRU = 13 
EXCH Allocation #3 PRU = 17 
EXCH Allocation #4 PRU = 21 

Slot #1 MCS 64QAM-3/4 
Validity 2 

PRU Concatenation ON 
Data Type PN23 

7. Click the Show Frame Structure button to confirm the channel 
allocation for each PRU. Close the Frame Structure screen after 
completing the confirmation. 

8. Click Calculation. While the Export File screen is displayed, input 
the Package name as XG-PHS, and the File name as 
DL_Type3_Test001. 

9. Click the OK button to start calculation while the Calculation screen 
is displayed. Click the OK button after calculation is completed to 
finish waveform creation. 

10. The DL_Type3_Test001.wvi, and DL_Type3_Test001.wvd files are 
output to the path X:\IQproducer\XG-PHS\Data installed by this 
software (X:\IQproducer indicates the folder installed by 
IQproducer™). 
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3.2.2 EXCH 
This section explains EXCH channel coding. 

If an even number of EXCH PRUs in a slot are set to be valid, every CRC 
Unit for that slot becomes 2PRU. If an odd number of EXCH PRUs in a 
slot are set to be valid, the last CRC Unit in that slot becomes 1PRU, but 
the other CRC Units become 2PRU. 

For example, if four EXCH PRUs in a slot are set to be valid, every two 
PRUs make up 1 CRC Unit, resulting in two CRC Units being created in 
this slot. 

In addition, if five EXCH PRUs in a slot are set to be valid, the last PRU 
makes up 1 CRC Unit and every two of the other PRUs make up 1 CRC 
Unit from the beginning. 

 

PRU PRU 

1CRC Unit 
4PRU

PRU PRU

1CRC Unit

Channel Coding 

Data Symbol Mapping 

… 
… 
… 
… 

1st CRC Unit 2nd CRC Unit 

PRU PRU 

1CRC Unit 5PRU

PRU PRU

1CRC Unit

Channel Coding 

Data Symbol Mapping 

… 
… 
… 
… 

1st CRC Unit 
2nd CRC Unit 

PRU

1CRC
Unit 

3rd CRC Unit

625 ms 

625 ms 

Concatenation length = 5PRU 

Concatenation length = 4PRU 

 

Figure 3.2.2-1  Example of PRU Concatenation 
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3.3 Saving/Recalling Parameters 
The numeric values and settings for each item can be saved in a 
parameter file by using this software. 

3.3.1 Saving parameter file 
When running on PC or MS2690A/MS2691A/MS2692A 

1. Select Save Parameter File from the File menu or click the   
tool button to display the parameter file saving screen. 

 

Figure 3.3.1-1  Parameter file saving screen 

2. Specify Save in, input a file name in the File name text box, and 
click Save to save the parameter file.  

 

When running on MG3710A 

1. Click the Save Parameter File button in File menu or click the   
button to display the parameter file saving screen.  

 

Figure 3.3.1-2  Parameter file saving screen (MG3710A) 
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2. Select the folder to store the file in the Directories field, and then 
enter the name of the file using the File Name box. Click OK to save 
the parameter file. To initialize the setting in the Directories field, 
click the Default Root button. 

 

3.3.2 Recalling parameter file 
When running on PC or MS2690A/MS2691A/MS2692A  

1. Select Recall Parameter File from the File menu or click the   
tool button to display the parameter file recalling screen.  

 

Figure 3.3.2-1  Parameter file recalling screen 

2. Select the parameter file to be read from the file list, and click Open 
to recall the selected parameter file. 

 
When running on MG3710A 

1. Select Recall Parameter File from the File menu or click the  
tool button to display the parameter file reading screen.  

 

Figure 3.3.2-2  Parameter file recalling screen (MG3710A) 
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2. Select the directory where the files to be loaded is stored in the 
Directories field. Click the desired file from the File List, and click 
OK. To initialize the setting in the Directories field, click the Default 
Root button. 



 

3.4 User File Reading Screen 

3-51 

3 

D
etailed D

escription
 of F

u
n

ction
s 

3.4 User File Reading Screen 
When running on PC or MS2690A/MS2691A/MS2692A  

1. When User File is selected in each layer, the user file reading screen 
is displayed. 

 

Figure 3.4-1  User File Reading Screen 

 

2. Select the user file to be read from the file list, and then click Open 
to read the selected user file. 

If an unsupported User File is selected, an error is displayed. Refer to 
Appendix B “User File Format” for details on the user file format. 

When running on MG3710A 

1. When User File is selected for Data Type setting in the Channel 
Setting screen, the user file reading screen is displayed.  

 

Figure 3.4-2  User File Reading Screen (MG3710A) 

 

2. Select the directory where the user files to be loaded is stored in the 
Directories field. Click the desired file from the File List, and click 
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OK. To initialize the setting in the Directories field, click the Default 
Root button.  

If an unsupported User File is selected, an error is displayed. Refer to 
Appendix B “User File Format” for details on the user file format. 
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3.5 Displaying Graphs 
The generated waveform pattern can be displayed in a CCDF, FFT, and 
Time Domain graph by using this software. For details of each graph 
display, refer to each one of the following: 

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.3 “CCDF Graph Display”, 4.4 “FFT Graph Display”, 4.13 “Time 
Domain Graph Display” 

 MS2690A/MS2691A/MS2692A or MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.3 “CCDF Graph Display”, 4.4 “FFT Graph Display”, 4.9 “Time 
Domain Graph Display” 

 

Displaying CCDF graph 

1. Generate a waveform pattern menu by executing Calculation. 

2. Select CCDF from the Simulation menu or click the  tool 
button. The CCDF Graph Monitor screen is displayed with the trace 
of the generated waveform pattern. 

 

Figure 3.5-1  CCDF Graph Monitor screen 
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When a waveform pattern is generated by changing parameters and 
executing Calculation while other traces are displayed in the CCDF 
Graph Monitor screen, the trace of the newly generated waveform 
pattern can be displayed by either of the following two methods: 

 Displaying new trace in same screen as previous traces 

 Deleting previous traces to display new trace 
 

Note: 

CCDF, FFT, and Time Domain graphs cannot be created 
simultaneously. To display all these graphs, complete creation of 
each graph and then create a separate graph.  

 
 Displaying new trace in same screen as previous traces 

1. Set Add for Quick Add Mode on the lower-left of the CCDF Graph 
Monitor screen. 

2. Select CCDF from the Simulation menu or click the  tool 
button. The trace of the newly generated waveform pattern is 
additionally displayed in the CCDF Graph Monitor screen. 
Up to four traces can be displayed by repeating this procedure. 

 Deleting previous traces to display new trace: 

1. Set Clear for Quick Add Mode on the lower-left of the CCDF 
Graph Monitor screen. 

2. Select CCDF from the Simulation menu or click the  tool 
button. The confirmation dialog shown in Figure 3.5-2 below is 
displayed: 

 

Figure 3.5-2  Confirmation dialog 

 

 Click the Yes button. The previous traces are deleted, and the 
trace of the newly generated waveform pattern is displayed. 
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Displaying FFT graph 

1. Generate a waveform pattern by executing Calculation. 

2. Select FFT from the Simulation menu or click the  tool button. 
The FFT Graph Monitor screen is displayed with the trace of the 
generated waveform pattern. 

 

Figure 3.5-3  FFT Graph Monitor screen 

 

 When a waveform pattern is generated by changing parameters and 
executing Calculation while other traces are displayed in the FFT 
Graph Monitor screen, the trace of the newly generated waveform 
pattern can be displayed by either of the following two methods: 

 Displaying new trace in same screen as previous traces 

 Deleting previous traces to display new trace 
 

Note: 

CCDF, FFT, and Time Domain graphs cannot be created 
simultaneously. To display all these graphs, complete creation of 
each graph and then create a separate graph. 
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 Displaying new trace in same screen as previous traces 

1. Set Add for Quick Add Mode on the lower-left of the FFT Graph 
Monitor screen. 

2. Select FFT from the Simulation menu or click the  tool 
button. The trace of the newly generated waveform pattern is 
additionally displayed in the FFT Graph Monitor screen. 
Up to four traces can be displayed by repeating this procedure. 

 When deleting previous traces to display new trace: 

1. Set Clear for Quick Add Mode on the lower-left of the FFT Graph 
Monitor screen. 

2. Select FFT from the Simulation menu or click the  tool 
button. The confirmation dialog shown in Figure 3.5-4 below 
appears: 

  

Figure 3.5-4  Confirmation dialog 

 

 Click the Yes button. The previous traces are deleted, and the 
trace of the newly generated waveform pattern is displayed. 
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Displaying Time Domain graph 

1. Generate a waveform pattern by executing Calculation. 

2. Select Time Domain from the Simulation menu or click the  
tool button. The Time Domain Graph Monitor screen shown in 
Figure 3.5-5 is displayed with the trace of the generated waveform 
pattern. 

 

 

Figure 3.5-5  Time Domain screen 

 

When a waveform pattern is generated by changing parameters and 
executing Calculation while other traces are displayed in the Time 
Domain Graph Monitor screen, the trace of the waveform pattern 
newly generated can be displayed by either of the following two 
methods: 

 Displaying new trace in same screen as previous traces 

 Deleting previous traces to display new trace 
 

Note: 

CCDF, FFT, and Time Domain graphs cannot be created 
simultaneously. To display all these graphs, complete creation of 
each graph and then create a separate graph. 
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 Displaying new trace in same screen as previous traces 

1. Set Add for Quick Add Mode on the lower-left of the Time Domain 
Graph Monitor screen. 

2. Select Time Domain from the Simulation menu or click the  
tool button. The trace of the newly generated waveform pattern is 
additionally displayed in the Time Domain Graph Monitor screen. 
Up to four traces can be displayed by repeating this procedure. 

■ Deleting previous traces to display new trace: 

1. Set Clear for Quick Add Mode on the lower-left of the Time 
Domain Graph Monitor screen. 

2. Select Time Domain from the Simulation menu or click the  
tool button. The confirmation dialog shown in Figure 3.5-6 below 
appears: 

 

Figure 3.5-6  Confirmation dialog 

 

 Click the Yes button. The previous traces are deleted, and the 
trace of the newly generated waveform pattern is displayed. 
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3.6 Auxiliary Signal Output 
When selecting waveform patterns created using XG-PHS IQproducer™ 
at the MS2690A/MS2691A/MS2692A, a marker that is synchronized to 
an RF signal can be output from the AUX Input/output connectors on the 
back panel as an auxiliary signal. 

For details of Marker Edit function, refer to each one of the following: 

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.13.12 “Marker edit function” 

 MS2690A/MS2691A/MS2692A or MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.9.12 “Marker edit function” 

 

3.6.1 Downlink, Uplink 
When creating waveform patterns, markers can be set automatically in 
the waveform pattern as shown below.  

 Frame Pulse 
A pulse that is synchronized with the beginning of the frame is output 
from Connector 1. Change Polarity for Marker 1 to change the signal 
polarity. 

 Slot Pulse 
A pulse that is synchronized with the beginning of the slot is output 
from Connector 2. Change Polarity for Marker 2 to change the signal 
polarity. 

A waveform pattern with edited markers can be created using the 
Marker Edit function for Time Domain graphs. 

For the error range of the auxiliary signals against the RF output, refer 
to each one of the following: 

 MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
4.5.6 “Input file format” 

 MS2690A/MS2691A/MS2692A or MS2830A Vector Signal Generator 
Operation Manual (IQproducer™) 
4.5.6 “Input file format” 
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The following operations are required to output a modulated signal from 
this equipment using the waveform pattern generated by this software: 

• Transferring waveform pattern to internal hard disk 
• Loading waveform patterns from the hard disk to the waveform 

memory 
• Selecting a waveform pattern to be output from this equipment 
 
This chapter explains the details of these operations. 
 

4.1 For MG3700A or MG3710A ....................................... 4-2 
4.1.1 Transferring waveform pattern to internal  

hard disk ........................................................ 4-2 
4.1.2 Loading to Waveform Memory ...................... 4-4 
4.1.3 Selecting Waveform Pattern .......................... 4-5 

4.2 For MS2690A/MS2691A/MS2692A ........................... 4-6 
4.2.1 Transferring waveform pattern to internal  

hard disk ........................................................ 4-6 
4.2.2 Loading to Waveform Memory ...................... 4-6 
4.2.3 Selecting Waveform Pattern .......................... 4-7 
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4.1 For MG3700A or MG3710A 
This section describes how to download a waveform pattern created for 
the MG3700A/MG3710A to the hard disk of the MG3700A/MG3710A and 
output the pattern.  

4.1.1 Transferring waveform pattern to internal hard disk 
The waveform pattern created with this software can be transferred to 
the internal hard disk in the following ways:  

Note: 
This operation is not necessary if you are using MG3710A and 
have generated waveform patterns on MG3710A.  

For MG3700A 
• LAN 
• CompactFlash Card 
 
For MG3710A 
• LAN 
• External device such as USB Memory 
 
■Transferring from PC via LAN (MG3700A，MG3710A) 
Two IQproducerTM tools can be used to transfer a waveform pattern to 
the MG3700A/MG3710A via a LAN.  

• Transfer & Setting Wizard 
Start this wizard by clicking the Transfer & Setting Wizard button of 
this software or by selecting Simulation & Utility tab → Transfer & 
Setting Wizard from the IQproducerTM after creating a waveform 
pattern. For details, refer to Section 4.7 “File Transfer and Loading to 
Memory Using Transfer & Setting Wizard” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™).  
Transferring a waveform pattern to the internal hard disk of the 
MG3700A/MG3710A, loading the waveform from the hard disk to the 
waveform memory, and then outputting the waveform pattern can be 
done using this wizard.  
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• Transfer & Setting Panel 
This function is loaded by selecting Transfer & Setting Panel in the 
Simulation & Utility tab of the IQproducer™. For details, refer to 
Section 5.2 “Transferring Waveform Pattern” in the 
MG3700A/MG3710A MG3740A Analog Signal Generator Operation 
Manual IQproducer™.  
Specify the folder that contains the waveform pattern to transfer to 
the MG3700A/MG3710A in the PC-side tree of Transfer & Setting 
Panel. 
 

■Transferring using a CF card (MG3700A) 
Copy the waveform pattern (***.wvi and ***.wvd files) to be downloaded 
to the MG3700A to the root directory of a CF card.  

Insert the CF card into the card slot on the front panel of the MG3700A, 
and then copy the file to the hard disk. For details about how to use a CF 
card to transfer a waveform pattern, refer to (1) Loading waveform file in 
memory in Section 3.5.2 of the MG3700A Vector Signal Generator 
Operation Manual (Mainframe). 

■Transferring via external device such as USB memory (MG3710A) 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MG3710A, refer to Section 7.3.6 “Copying 
external waveform pattern: Copy” in the MG3710A Vector Signal 
Generator MG3740A Analog Signal Generator Operation Manual 
(Mainframe).  
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4.1.2 Loading to Waveform Memory 
To output a modulated signal using a waveform pattern, it is necessary to 
load the waveform pattern that was transferred to the internal hard disk 
of the MG3700A/MG3710A (described in Section 4.1.1 “Transferring 
waveform pattern to internal hard disk”) to the waveform memory. A 
waveform pattern can be loaded into the waveform memory in the 
following two ways.  

■Configuring using the mainframe  
A waveform pattern can be loaded into the waveform memory by using 
the instruction panel of the MG3700A/MG3710A or by using a remote 
command.  

For operation using the front panel, refer below: 

• Section 3.5.2 (1) “Loading waveform file in memory” in the MG3700A 
Vector Signal Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal 
Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
■Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory by using Transfer & Setting Panel, which can be opened from 
the Simulation & Utility tab. For details, refer to Section 4.6 “File 
Transfer and Loading to Memory Using Transfer & Setting Panel” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (IQproducer™). 
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4.1.3 Selecting Waveform Pattern 
Select a waveform pattern to use for modulation from the waveform 
patterns loaded into the waveform memory of the MG3700A/MG3710A 
according to Section 4.1.2 “Loading to waveform memory”. A waveform 
pattern can be selected in the following two ways. 

■Configuring using the MG3700A/MG3710A 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.  

For operation using the front panel, refer below:  

• Section 3.5.2 (4) “Outputting pattern loaded in Memory A for 
modulation in Edit mode” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 

■Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory, and also selected for modulation. This is done by using Transfer 
& Setting Panel, which can be opened from the Simulation & Utility tab. 
For details, refer to Section 4.6 “File Transfer and Loading to Memory 
Using Transfer & Setting Panel” in the MG3700A/MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(IQproducer™). 
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4.2 For MS2690A/MS2691A/MS2692A  
This section describes how to download a waveform pattern created for 
the MS2690A/MS2691A/MS2692A to the hard disk of the 
MS2690A/MS2691A/MS2692A and output the pattern.  

 

4.2.1 Transferring waveform pattern to internal hard disk 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MS2690A/MS2691A/MS2692A, refer 
below: 

• Section 2.4.4 “Copying waveform file(s) to hard disk” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 

 

Note: 
Transferring waveform patterns is not required if the patterns are 
created using this software. 

 

4.2.2 Loading to Waveform Memory 
In order to output a modulated signal using the waveform pattern, it is 
necessary to load the waveform patterns stored in the internal hard disk 
to the waveform memory.  

■Loading to Waveform Memory 
Waveform patterns can be loaded to waveform memories by operating the 
panel or by using a remote command.  

For operation using the front panel, refer below: 

• Section 2.4.1 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 
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For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 
 

4.2.3 Selecting Waveform Pattern 
Select waveform patterns to be used for modulation from those loaded in 
the waveform memory as described in Section 4.2.1 “Transferring 
waveform pattern to internal hard disk” above. 

■Selecting waveform pattern 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.   

For operation using the front panel, refer below: 

• Section 2.4.2 “Loading waveform file in memory” in the 
MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Operation) 
 
 

For operation using remote commands, refer below: 

• MS2690A/MS2691A/MS2692A Signal Analyzer Option 020: Vector 
Signal Generator Operation Manual (Remote Control) 
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A list of error messages is shown below. In this list, x, n1, and n2 indicate 
a numeric value, and s indicates a character string. 

Table A-1  Error messages 

Error Message Description 
Available memory is low. – 
Cannot open file – 
Cannot read file – 
Cannot read file(“s”) – 
Cannot write file – 
Cannot write file(“s”). – 
Input Export File Name. – 
Input Package Name. – 
Invalid file format – 

The Setting value is out of range. (“s = x(n1 – n2)”) The value of x set in parameter s is out of the 
setting range between n1 and n2. 

CCCH should be allocated to one or two fixed 
SCH. – 

Selection of an inaccurate file.("") – 
The PRU "s" is allocated already. – 
Disk full 
Cannot generate new waveform pattern. – 

Folder or media not found. 
Aborted with error. – 

The Waveform data file is not generated. No waveform pattern. Create a waveform pattern 
to be displayed. 

 
A list of warning message is shown below. 

Table A-2  Warning message 

Error Message Description 

Clipping was done. – 
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This section shows examples of the user file format that can be used in 
the this software. A user file must be a text file. It is not necessarily 
required to specify an extension to user files. Note that an error occurs if 
a user file that does not conform to the format is read.  

Be sure to write an unmodulated binary sequence into a user file. An 
error occurs if a user file that contains a numeric value other than 0 or 1, 
a character, or a symbol other than a comma or period is read. 
All line feeds, commas, periods, and spaces in a user file are ignored 
when the user file is read. 
A user file format example is shown below. 

User file format example   
 
0s and 1s in a user file are sequentially read from the leftmost of the first 
line. 

When the number of data to be processed is larger than that in the user 
file, the data is set to 0s. If the user file contains more data than that to 
be processed, data reading terminates halfway. 
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